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This chapter introduces Open Transport 1.1. You can save time later if you
take a few minutes now to learn about Open Transport and what you use 
it for.

What is Open Transport?

Open Transport is the modern, industry-standard networking and
communications software for the Mac OS. Open Transport 1.1 is the first
version designed to run on a wide range of Macintosh computers. With Open
Transport software installed on your computer, you can

m use more than one networking system at once (for example, AppleTalk to
communicate with network printers and TCP/IP to connect to the Internet)

m save and modify different networking configurations

m switch among networking configurations quickly and easily

Open Transport includes the AppleTalk and TCP/IP control panels. These
replace the Network and MacTCP control panels used in previous versions of
the Mac OS. You can use Open Transport on any Mac OS computer that uses
a PowerPC processor, or a 68030 or 68040 processor. Open Transport is
required on any Mac OS computer that uses the PCI bus.

1
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To use Open Transport, you first install the software onto your Mac OS
computer. The Open Transport Installer places the AppleTalk and TCP/IP
control panels into your Control Panels folder. You use the AppleTalk control
panel to set up your connection to an AppleTalk network (that is, a network
using the AppleTalk protocol). You use the TCP/IP control panel to set up
your connection to the Internet, and to a TCP/IP network. TCP/IP stands for
Transmission Control Protocol/Internet Protocol, an industry-standard system
for connections between computers of different types.

About this book

This book is for Open Transport users and for administrators of networks that
include computers that use Open Transport. Here’s what you’ll find in the
remaining chapters:

m Chapter 2 provides instructions for installing the Open Transport 1.1
software on your computer. If you received Open Transport 1.1 with a Mac
OS computer, the software has been installed for you, and you can skip
Chapter 2. (If you are using a previous version of Open Transport, you
should upgrade to version 1.1.)

m Chapter 3 describes how to use the AppleTalk control panel to set up and
control your connection to an AppleTalk network.

m Chapter 4 describes how to use the TCP/IP control panel to set up and
control your connection to a network that uses TCP/IP, such as an Ethernet
network or the Internet.

m Chapter 5 provides troubleshooting suggestions.

What you need to know before you begin

This book assumes that you have basic Macintosh skills. You should know
how to

m use the mouse and keyboard

m choose commands from menus

m open folders and application programs

m save documents
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If you need to learn more about these basic tasks, consult the learning
materials that came with your computer.

You may need additional information about the network to which your
computer is connected, or about the service through which your computer is
connected to the Internet. To get this information, you may need to contact
your network administrator or your Internet service provider. See Chapters 3
and 4 for details about the information you need and where to look for it.

Other sources of information

In addition to this book, you can take advantage of the onscreen instruction
built into Open Transport—Balloon Help and (if you are using system
software version 7.5.3 or later) Apple Guide instructions.

When Balloon Help for Open Transport is turned on, you can get information
about any item on the screen simply by pointing to the item with the mouse.

You can get step-by-step instructions for using the Open Transport control
panels with Macintosh Guide, available in the Guide (h) menu when the
Finder is the active program.

There may be late-breaking news about Open Transport that is not included
in this book. Open the Read Me file that came with Open Transport to find
additional information. This file also includes information on the new
features of Open Transport version 1.1.
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Before you can set up Open Transport and begin using it, you need to install
the software.

IMPORTANT If you received Open Transport 1.1 packaged with a Mac OS
computer, the software has already been installed on your computer. Skip this
chapter and continue with Chapter 3. If you are using a previous version of
Open Transport, you should upgrade to version 1.1. If you are not sure what
version of Open Transport is installed on your computer, open the AppleTalk
control panel (in your Control Panels folder) and choose Get Info from the
File menu. A window appears with information about the version of Open
Transport you have installed. 

What do you need to use Open Transport?

Your computer must have the following features to use Open Transport 1.1:

m a PowerPC central processing unit (CPU) or a 68030 or 68040 CPU

m at least 8 megabytes (MB) of random-access memory (RAM)

m system software version 7.1, 7.1.1, 7.1.2, or 7.5.3 (system software version 7.5.3
or later is recommended)
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Installing Open Transport the easy way

To install Open Transport on your hard disk, you use the Installer program on
the first installation disk included in the Open Transport package. This
section describes the basic Open Transport installation (called “Easy Install”)
that gives you the software you need in most cases. For instructions on
installing specific portions of Open Transport software, see the next section,
“Doing a Custom Installation.”

1 Turn on your computer and wait until the Mac OS desktop appears.

2 Insert the first Open Transport installation disk.

3 Double-click the Installer icon.

A screen appears welcoming you to the Open Transport Installer.

Note:  If you are installing over an older version of Open Transport, you may
see messages during the installation asking if you want to install newer
versions of files that already exist on your hard disk. Make sure you always
choose to install the new versions of each file.
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4 Click Continue.

After a few moments, this window appears:

Make sure you see in the Destination Disk box the name of the disk on which
you want to install Open Transport. You can install Open Transport on any
hard disk that has the correct version of system software installed. If you 
don’t see the correct name, click Switch Disk until you see the name of the
disk you want.

5 Click Install.

If any application programs are running, the Installer prompts you to quit
those programs.

A status screen shows you the progress of the installation. When the
installation is complete, a message tells you so.
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6 Click Restart to exit from the Installer program and restart the computer.

You have finished installing Open Transport. To set up and use the AppleTalk
control panel, turn to Chapter 3. To set up and use the TCP/IP control panel,
turn to Chapter 4. If you don’t know which control panel to use, consult your
network administrator or Internet service provider.

Doing a custom installation

To install specific parts of Open Transport, follow these steps:

1 Turn on your computer and wait until the Mac OS desktop appears.

2 Insert the first Open Transport installation disk.

3 Double-click the Installer icon.

A screen appears welcoming you to the Open Transport Installer.

4 Click Continue.

After a few moments, this window appears:
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5 Choose Custom Install from the pop-up menu.

Make sure you see in the Destination Disk box the name of the disk on which
you want to install Open Transport. You can install Open Transport on any
hard disk that has the correct version of system software installed. If you 
don’t see the correct name, click Switch Disk until you see the name of the
disk you want.

6 In the window that appears, choose the items you want to install.
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7 Click Install.

If any application programs are running, the Installer prompts you to quit
those programs.

A status screen shows you the progress of the installation. When the
installation is complete, a message tells you so.

8 Click Restart to exit from the Installer program and restart the computer.

You have finished installing Open Transport. To set up and use the AppleTalk
control panel, turn to Chapter 3. To set up and use the TCP/IP control panel,
turn to Chapter 4. If you’re not sure which control panel to use, consult your
network administrator or Internet service provider.
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You use the AppleTalk control panel when your computer is connected to a
network that uses the AppleTalk protocol. A network using the AppleTalk
protocol may use LocalTalk, Ethernet, or other types of cabling. If you don’t
know whether your network uses the AppleTalk protocol, contact your
network administrator.

Read the instructions in this chapter to accomplish the following tasks with
the AppleTalk control panel:

m specify the port through which your computer is connected to the network

m choose the network zone in which your computer appears (if your network
allows this)

m use configurations to change all your settings at once

m see and use Basic, Advanced, and Administrative settings

m get information about your AppleTalk setup

m turn AppleTalk on and off
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Getting help in the AppleTalk control panel

When the AppleTalk control panel is open, you can get two types of onscreen
help: Balloon Help and Macintosh Guide. Turn on Balloon Help to find out
more about the items in the control panel windows. Use Macintosh Guide for
step-by-step instructions about using the control panel. (Macintosh Guide is
available only if you have system software version 7.5.3 or later.) Balloon Help
and Macintosh Guide are available in the Guide (h) menu. (Macintosh Guide
is only available in the menu when the Finder is the active program.) In
addition, you can open Macintosh Guide by clicking the Guide (h) button in
the lower-left corner of each control panel window.

Setting up your AppleTalk network connection

To set up your AppleTalk network connection, you must specify the port you
use to connect your computer to the network. If your network has more than
one zone, you can choose the zone in which your computer is located. The
zone you choose is the zone that is automatically selected in the Chooser (for
example, when you select a network printer) and it is the zone in which other
network users can find your computer if you turn on file sharing. 

To set up your network connection, follow these steps:

1 Choose Control Panels from the Apple (K) menu.

The Control Panels window opens.
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2 Double-click the AppleTalk icon to open it.

The AppleTalk control panel opens.

3 Use the “Connect via” pop-up menu (if available) to choose the port by which your
computer is connected to the network.

4 Use the Current Zone pop-up menu (if available) to choose the zone you want.
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With Open Transport, you can connect to an
AppleTalk network through the printer port, the modem
port, or any additional ports installed in your computer.
If you have more ports installed, they appear
automatically in this pop-up menu.

If you don’t see a pop-up menu here, this setting has
been locked or your network is not set up to allow you
to choose a different zone. Zones are set up by the
network administrator.

If you don’t see a pop-up menu here, this setting has
been locked or your computer has only one port. You
use the Administration user mode to lock and unlock
settings.



Working with AppleTalk configurations

An “AppleTalk configuration” is a collection of settings you make in the
AppleTalk control panel. The group of settings currently displayed in the
control panel is the active configuration. 

You can save different groups of settings (configurations) and switch among
them as desired—for example, if you use your computer in more than one
location.

m Make sure the AppleTalk control panel is open, and choose Configurations from the 
File menu.

The Configurations window opens.

Choosing a configuration

If you see the configuration you want in the list, click it, then click Make
Active. The Configuration window closes, and the configuration you chose
takes effect.
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Making a new configuration

You make a new configuration by starting with an existing one and modifying
it. To create a new configuration, follow these steps:

1 In the configuration list, click to select the configuration you want to modify.

2 Click Duplicate.

3 In the window that appears, type a name for the new configuration, then click OK.

The new configuration name appears in the list.

4 Click the new configuration name, then click Make Active.

The Configurations window closes.

5 Make any changes you want to the control panel settings.

6 Click the close box to close the control panel (or choose Quit from the File menu).

A box appears asking if you want to save the changes you made to the
configuration.

7 Click Save.

The new configuration is saved with the changes you made. The next time
you open the AppleTalk control panel, your new configuration will still be in
effect.

Saving a configuration as a file

You can save (export) a configuration as a file separate from the AppleTalk
control panel. You can use (import) the file to automatically duplicate the
control panel settings on another computer using Open Transport. To save a
configuration as a file, follow these steps:

1 In the Configurations window, click to select the configuration you want to save as a file.

2 Click Export.

3 In the box that appears, type a name for the configuration file, and choose the folder or
disk where you want to save it.
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4 Click Save.

Your configuration is saved as a file in the location you chose with the name
you specified.

Opening and using a saved configuration

You can open and use (import) a configuration file that has been exported
from the AppleTalk control panel. To open and use a configuration file, follow
these steps:

1 In the Configurations window, click Import.

2 In the box that appears, click to select the configuration file you want to use.

3 Click Import.

The configuration is imported into the Configurations window.

4 Click Make Active.

The settings specified in the imported configuration take effect immediately.

Choosing Basic, Advanced, or Administration settings

When you first open the AppleTalk control panel, you see only the basic
settings. Basic settings provide the controls you need in most cases. To see or
change other settings, you must change the user mode from Basic to
Advanced or Administration. Settings you make in Advanced and
Administration mode stay in effect if you change to Basic mode, even though
you may not be able to see the settings.

IMPORTANT The Advanced and Administrative modes include settings that
can cause network problems if used improperly. If you are not sure how to use
Advanced or Administration settings, leave the settings unchanged until you
check with your network administrator. 
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In Basic mode, the AppleTalk control panel looks like this:

In Advanced mode, the AppleTalk control panel looks like this:

In Administration mode, the AppleTalk control panel looks like this:

For more information about using Administration mode, see the next section,
“Using Administration Mode.”
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In Basic mode, you can see and 
usually change the port and 
your computer’s current zone.

In Advanced mode, you can see and usually change
your computer’s network address. 

WARNING Do not do this unless you are sure your
address information is correct.

Click Options to turn AppleTalk off
or on again.

In Administration mode, you can lock settings so they
can’t be changed. To lock a setting, click the lock
button. To unlock it, click again.

Click Info for details
about your settings.



To change the user mode, follow these steps:

1 With the AppleTalk control panel open, choose User Mode from the Edit menu.

2 In the dialog box that appears, choose the mode you want, then click OK.

If you choose Administration mode, and it has been protected by a password,
a box appears to enter the password.

The main control panel window changes to reflect the mode you chose. 
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Using Administration mode

When you’re in Administration mode, you can lock and unlock settings, and
set a password limiting access to Administration mode. To set a password,
follow these steps:

1 With the AppleTalk control panel open, choose User Mode from the Edit menu.

2 In the window that appears, click the Administration button.

3 Click Set Password.

4 In the box that appears, type the password you want to use.

When you type the password, you see dots (•) instead of the letters you type.

5 Type the password again to make sure you typed it correctly, then click OK.

If you change the user mode to Basic or Advanced, you must use the
password to change the mode back to Administration.

Locking settings

To lock settings, set the AppleTalk control panel to Administration mode, then
click the lock icon next to each setting you want to lock. Click again to unlock
a setting. If you change the user mode to Basic or Advanced, the settings you
lock cannot be changed.
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Getting information about your settings

For detailed information about the AppleTalk addresses and software versions
currently in effect, do this:

m Choose Get Info from the File menu.

If the control panel is in Advanced or Administration mode, you can also
click the Info button.

The AppleTalk Info window opens. You can see information in this window,
but you cannot change it.

This Macintosh address

Your computer’s AppleTalk address is a number that uniquely identifies it on
the network. The number to the left of the dot is your computer’s network
number. The number to the right of the dot is the node number. Unless you
choose to set a specific AppleTalk address (which is not recommended), your
computer chooses an AppleTalk address every time it starts up. This means
that the number you see may be different if you shut down and restart your
computer.
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Hardware address

The hardware address is a number identifying the port you use to connect
your computer to the network. Ethernet ports and many networking
expansion cards have hardware addresses. Your computer’s serial ports do not
have hardware addresses.

Router address

A router is a device (or a program running on a network device) that directs
information along the most efficient or appropriate network paths. It is
connected to a network at a point between two or more groups of computers
and other network devices, and it contains a list identifying the addresses of
the computers in each group. When a packet of information reaches the
router, the router checks the address of the computer the packet is being sent
to and directs it to the part of the network containing that address.

The AppleTalk Info window shows the network address of the router
currently being used by your computer. This address may not always be the
same because your computer’s AppleTalk software constantly looks for the
best router to use. When conditions on the network change, the software may
choose a different router.

If no address is available, it means that your computer was unable to find a
router, or your network does not have any routers.
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Turning AppleTalk on and off

When you are not using an AppleTalk network, you can turn AppleTalk off to
save RAM in your computer. When you need to use AppleTalk again, you can
turn it on. To turn AppleTalk on and off, follow these steps:

1 Make sure the user mode is set to Advanced or Administration.

For instructions on changing the user mode, see “Choosing Basic, Advanced,
or Administration Settings,” earlier in this chapter.

2 Click Options.

3 In the window that appears, click to turn AppleTalk on (active) or off (inactive), then 
click OK.

AppleTalk becomes active or inactive as soon as you click OK.
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You use the TCP/IP control panel when your computer is connected to a
network that uses TCP/IP standards. TCP/IP (Transmission Control
Protocol/Internet Protocol) is a standard set of rules (or protocols) for making
connections among different types of computers. TCP/IP protocols can be
used with many different types of network hardware, including LocalTalk,
Ethernet, and dialup Internet connections. If you don’t know whether your
network uses TCP/IP, contact your network administrator.

Read the instructions in this chapter to accomplish the following tasks with
the TCP/IP control panel:

m specify your network connection

m enter your IP address and subnet mask (or identify the server from which
they are available)

m use configuration files

m see and use Basic, Advanced, or Administration settings

m get information about your TCP/IP setup

m turn TCP/IP on and off

m understand the various settings in the TCP/IP control panel
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Getting help in the TCP/IP control panel

When the TCP/IP control panel is open, you can get two types of onscreen
help: Balloon Help and Macintosh Guide. Turn on Balloon Help to find out
more about the items in the control panel window. Use Macintosh Guide for
step-by-step instructions about using the control panel. (Macintosh Guide is
available only if you have system software version 7.5.3 or later.) Balloon Help
and Macintosh Guide are available in the Guide (h) menu. (Macintosh Guide
is only available in the menu when the Finder is the active program.) In
addition, you can open Macintosh Guide by clicking the Guide (h) button in
the lower-left corner of the control panel window.

Setting up your TCP/IP network connection

To set up your TCP/IP network connection, you must specify the port you use
to connect your computer to the network. TCP/IP networks also require
information about your computer’s network address. You must enter that
information in the control panel, or specify a server on which the information
can be found.

You can make it easier to find network services by entering addresses of name
servers and domain names you want to use. Name servers work like
automatic phone books for locating network services and domain names are
like postal addresses for locating network services. This information may also
be provided by a server, if your network includes a server with this capability.

Before you begin

To use a TCP/IP network, your computer must have an IP (Internet Protocol)
address, and it often must have a subnet mask number. This information can
be entered manually or obtained automatically from one of several types of
servers. Before you set up your TCP/IP network connection, obtain your IP
address and subnet mask number from your Internet service provider or
network administrator. If these can be obtained automatically from a server,
find out whether the server is a “BootP,” “RARP,” “DHCP,” or “MacIP”
server.
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“RARP” stands for Reverse Address Resolution Protocol. A RARP server can
provide the IP address for your computer (you must provide the rest
manually).

“BootP” stands for Boot Protocol. A BootP server can automatically provide
all the TCP/IP setup information you need. 

“DHCP” stands for Dynamic Host Configuration Protocol. A DHCP server
can automatically provide all the TCP/IP setup information you need. 

“MacIP” stands for Macintosh Internet Protocol. MacIP is both a type of
server and a protocol for sending Internet-type packets of information over
an AppleTalk network. A MacIP server can provide the IP address for your
computer.

Setting up

To set up your TCP/IP network connection, follow these steps:

1 Choose Control Panels from the Apple (K) menu.

The Control Panels window opens.

2 Double-click the TCP/IP icon to open it.

The TCP/IP control panel opens.
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3 Use the “Connect via” pop-up menu to choose the port by which your computer is
connected to the network.

4 Use the Configure pop-up menu to choose a configuration method.

If you are connected using Ethernet, the pop-up menu looks like this:

If you are connected using AppleTalk (MacIP), the pop-up menu looks 
like this:

Configuring TCP/IP manually for an Ethernet connection

You must configure TCP/IP manually if your service provider or network
administrator gave you an IP address (and possibly other information) to use.

IMPORTANT Make sure your IP address is correct. Entering an incorrect
address can cause problems on your computer and on the network.

To configure TCP/IP manually for use with an Ethernet port, follow these
steps:

1 Type the IP address number for your computer in the IP Address box.

An IP address is a set of four numbers from 0 to 255, separated by dots (for
example, 111.123.222.213). It identifies your computer on the network. 

2 If you have a subnet mask number, type it in the “Subnet mask” box.

Some networks are divided into sections called subnetworks, or subnets. A
subnet mask is a set of numbers used in conjunction with an IP address to
identify the subnetwork your computer is connected to. Like an IP address, a
subnet mask is a set of numbers from 0 to 255, separated by dots (for
example, 128.0.0.0). If you do not enter a subnet mask, Open Transport
provides a default value automatically.
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3 If you have a router address, type it in the “Router address” box.

A router address is the IP address for a router—a device that directs
information along the most efficient or appropriate network paths. It is
connected to a network at a point between two or more groups of computers
and other network devices, and it contains a list identifying the addresses of
the computers in each group. When a packet of information reaches the
router, the router checks the address on the packet and sends it to the part of
the network containing that address. If you don’t enter a router address, you
may not be able to access your whole network.

You can enter more than one router address (press the Return key after each
address you enter).

4 If you have additional information, type it in the appropriate boxes.

Name server address

A name server address is the IP address of a name server (or domain name
server)—a computer that makes available the network address numbers for
computers and other network devices that you know by name. For example, if
you want to find a host computer called “server.xyz.com,” a name server
could automatically match that name with an IP address (the computer-to-
computer address).
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user modes.



You can type more than one name server address in the name server address
box. Press Return after each address. You can list as many name servers as
you want as long as your list doesn’t total more than 255 letters and symbols.

Hosts file

The Select Hosts File button appears only when the TCP/IP control panel is
set to Advanced or Administration user mode. For instructions on setting the
user mode, see “Choosing Basic, Advanced, or Administration Settings,” later
in this chapter. 

A Hosts file is a list of DNS (Domain Naming System) resources. It is stored
on your computer’s hard disk. You use a Hosts file to easily access network
information you use frequently. This is the same function provided by name
servers. It is recommended that you use name servers rather than a Hosts file. 

Implicit search domains

The implicit search domain boxes appear only when the TCP/IP control panel
is set to Advanced or Administration user mode. For instructions on setting
the user mode, see “Choosing Basic, Advanced, or Administration Settings,”
later in this chapter. 

TCP/IP can automatically search for computers you partially identify (in a
networking application program) by “host name”—a name representing that
computer on the network. To make the search possible, you specify a name
representing a local network domain (the “starting name”) and a name
representing a larger domain containing the local domain (the “ending
name”). TCP/IP uses the domain names you enter to search for a valid host
name when you identify only part of the name.

For more information about domain names and how the search process
works, see “Name Servers, Domain Names, and Domain Searching,” later in
this chapter.
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Additional search domains

TCP/IP can search for computers in different domains than yours. You
specify the domains you want to search in the Additional Search Domains
box. Press the Return key after each domain name you type. You can list as
many search domains as you want as long as your list doesn’t total more than
255 letters and symbols.

For more information about domain names and how the search process
works, see “Name Servers, Domain Names, and Domain Searching,” later in
this chapter.

Configuring TCP/IP for use with an Ethernet server

To configure TCP/IP using a BootP server or a DHCP server, all you need to
do is choose the appropriate type of server from the Configure pop-up menu.
The server usually provides all the configuration information needed by
TCP/IP.

A RARP server provides only the IP address for your computer. If your
network uses subnets, and if you have additional TCP/IP configuration
information to enter, follow the instructions in the section “Configuring
TCP/IP Manually for an Ethernet Connection,” earlier in this chapter.

Configuring TCP/IP manually for a MacIP connection

You must configure TCP/IP manually if you are connected to the network
using AppleTalk and your service provider or network administrator gave you
an IP address (and possibly other information) to use.

To configure TCP/IP manually for use with MacIP, follow these steps:

1 Type the IP address number for your computer in the IP Address box.

An IP address is a set of numbers from 0 to 255, separated by dots (for
example, 111.123.222.213). It identifies your computer on the network. 
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2 If you have a subnet mask number, type it in the “Subnet mask” box.

Some networks are divided into sections called subnetworks, or subnets. A
subnet mask is a set of numbers used in conjunction with an IP address to
identify the subnetwork your computer is connected to. Like an IP address, a
subnet mask is a set of numbers from 0 to 255, separated by dots (for
example, 128.0.0.0). If you do not enter a subnet mask, Open Transport
provides a default value automatically.

3 If you have a router address, type it in the “Router address” box.

A router address is the IP address for a router—a device that directs
information along the most efficient or appropriate network paths. It is
connected to a network at a point between two or more groups of computers
and other network devices, and it contains a list identifying the addresses of
the computers in each group. When a packet of information reaches the
router, the router checks the address on the packet and sends it to the part of
the network containing that address. If you don’t enter a router address, you
may not be able to access your whole network.

You can enter more than one router address (press the Return key after each
address you enter).

4 If you have additional information, type it in the appropriate boxes.
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Name server address

A name server address is the IP address of a name server (or domain name
server)—a computer that makes available the network address numbers for
computers and other network devices that you know by name. For example, if
you want to find a host computer called “server.xyz.com,” a name server
could automatically match that name with an IP address (the computer-to-
computer address).

You can type more than one name server address in the name server address
box. Press Return after each address. You can list as many name servers as
you want as long as your list doesn’t total more than 255 letters and symbols.

Hosts file

The Select Hosts File button appears only when the TCP/IP control panel is
set to Advanced or Administration user mode. For instructions on setting the
user mode, see “Choosing Basic, Advanced, or Administration Settings,” later
in this chapter. 

A Hosts file is a list of DNS (Domain Naming System) resources. It is stored
on your computer’s hard disk. You use a Hosts file in order to easily access
network information you use frequently. This is the same function provided
by name servers. It is recommended that you use name servers rather than a
Hosts file. 

Implicit search domains

The implicit search domain boxes appear only when the TCP/IP control panel
is set to Advanced or Administration user mode. For instructions on setting
the user mode, see “Choosing Basic, Advanced, or Administration Settings,”
later in this chapter. 

TCP/IP can automatically search for computers you partially identify (in a
networking application program) by “host name”—a name representing that
computer on the network. To make the search possible, you specify a name
representing a local network domain (the “starting name”) and a name
representing a larger domain containing the local domain (the “ending
name”). TCP/IP uses the domain names you enter to search for a valid host
name when you identify only part of the name.

For more information about domain names and how the search process
works, see “Name Servers, Domain Names, and Domain Searching” later in
this chapter.
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Additional search domains

TCP/IP can search for computers in any domains you specify. You specify the
domains you want to search in the Additional Search Domains box. Press the
Return key after each domain name you type. You can list as many search
domains as you want as long as your list doesn’t total more than 255 letters
and symbols.

For more information about domain names and how the search process
works, see “Name Servers, Domain Names, and Domain Searching” later in
this chapter.

Configuring TCP/IP for use with a MacIP server

To configure TCP/IP for use with a MacIP server, follow these steps:

1 If necessary, click Select Zone to choose the zone of the MacIP server you want to use.

2 In the box that appears, choose the zone you want.

3 Click OK to close the MacIP zone dialog box.

Your TCP/IP configuration information is obtained from the MacIP server
when you attempt to open a networking connection (for example, by opening
a networking application program).

32 Chapter  4

Click Current Zone if your MacIP server is 
in the same zone as your computer. Click 
Selected Zone to choose a different zone.

Click here to show
only zones that have

MacIP servers. 
It may take a few
moments for this

button to become
available because

TCP/IP searches for
MacIP servers in all

zones first.



Working with TCP/IP configurations

A “TCP/IP configuration” is a way of referring to the collection of settings
you make in the TCP/IP control panel. The settings currently displayed in the
control panel are known as the active configuration. 

You can save different groups of settings (configurations) and switch between
them as desired. To work with multiple configurations, do this:

m Make sure the TCP/IP control panel is open, and choose Configurations from the File
menu.

The Configurations window opens.

Choosing a configuration

If you see the configuration you want in the list, click it, then click Make
Active.

Making a new configuration

You make a new configuration by starting with an existing one and modifying
it. To create a new configuration, follow these steps:

1 In the configuration list, click to select the configuration you want to modify.

2 Click Duplicate.
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3 In the window that appears, type a name for the new configuration, then click OK.

The new configuration name appears in the list.

4 Click the new configuration name, then click Make Active.

The Configurations window closes.

5 Make any changes you want to the control panel settings.

6 Click the close box to close the control panel (or choose Quit from the File menu).

A box appears asking if you want to save the changes you made to the
configuration.

7 Click Save.

The new configuration is saved with the changes you made. The next time
you open the TCP/IP control panel, your new configuration will still be 
in effect.

Saving a configuration as a file

You can save (export) a configuration as a file separate from the TCP/IP
control panel. You can use (import) the file to automatically duplicate the
control panel settings on another computer using Open Transport. To save a
configuration as a file, follow these steps:

1 In the Configurations window, click to select the configuration you want to save as a file.

2 Click Export.

3 In the box that appears, type a name for the configuration file, and choose the folder or
disk where you want to save it.

4 Click Save.

Your configuration is saved as a file in the location you chose with the name
you specified.
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Opening and using a saved configuration

You can open and use (import) a configuration file that has been exported
from the TCP/IP control panel. To open and use a configuration file, follow
these steps:

1 In the Configurations window, click Import.

2 In the box that appears, click to select the configuration file you want to use.

3 Click Import.

The configuration is imported into the Configurations window.

4 Click Make Active.

The settings specified in the imported configuration take effect immediately.

Choosing Basic, Advanced, or Administrative settings

When you first open the TCP/IP control panel, you see only the basic
settings. Basic settings provide the controls you need in most cases. To see or
change other settings, you must change the user mode from Basic to
Advanced or Administration. You use Administration mode to lock settings so
that other users cannot change them in Basic or Advanced mode. You can
further protect locked settings by setting a password to limit access to
Administration mode.

IMPORTANT The Advanced and Administration modes include settings that
can cause network problems if used improperly. If you are not sure how to use
Advanced or Administration mode, leave the settings unchanged until you
check with your network administrator.
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To choose a user mode, follow these steps:

1 With the TCP/IP control panel open, choose User Mode from the Edit menu.

2 In the dialog box that appears, choose the mode you want, then click OK.

If you choose Administration mode, and it has been protected by a password,
a box appears in which you enter the Administration password.

The main control panel window changes to the mode you chose. For more
information about using Administration mode, see the next section, “Using
Administration Mode.”

Using Administration mode

If you choose Administration mode, you can lock and unlock settings, and set
a password limiting access to Administration mode. To set a password, follow
these steps:

1 With the TCP/IP control panel open, choose User Mode from the Edit menu.

2 In the window that appears, click the Administration button to select it.

3 Click Set Password.

4 In the box that appears, type the password you want to use.

When you type the password, you see dots (•) instead of the letters you type.

5 Type the password again to make sure you typed it correctly, then click OK.

If you change the user mode to Basic or Advanced, you must use the
password to change the mode back to Administration.
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Locking settings

To lock settings, set the TCP/IP control panel to Administration mode, then
click the lock icon next to each setting you want to lock. Click again to unlock
a setting. When you change the user mode to Basic or Advanced, the settings
you lock cannot be changed.

Getting information about your settings

For detailed information about the TCP/IP addresses and software versions
currently in effect, do this:

m Choose Get Info from the File menu.

If the control panel is in Advanced or Administration mode, you can also
click the Info button.

The TCP/IP Info window opens. You can see information in this window, but
you cannot change it.
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Turning TCP/IP on and off

When you are not using a TCP/IP network, you can turn TCP/IP off to save
RAM in your computer. When you need to use TCP/IP again, you can turn it
on. You can also choose to have TCP/IP loaded into RAM all the time, or only
when needed (the recommended setting). To turn TCP/IP on and off, follow
these steps:

1 Make sure the user mode is set to Advanced or Administration.

For instructions on changing the user mode, see “Choosing Basic, Advanced,
or Administrative Settings,” earlier in this chapter.

2 Click Options.

3 In the dialog box that appears, choose the settings you want, then click OK.

TCP/IP becomes active or inactive immediately.

About TCP/IP settings

This section describes the settings available in the TCP/IP control panel, and
explains how TCP/IP uses the information you enter. 

IP address

An IP (Internet Protocol) address is a set of four numbers from 0 to 255,
separated by dots (for example, 111.123.222.213). It identifies your computer’s
connection to the network. You must have an IP address to use TCP/IP.

38 Chapter  4



The numbers in an IP address are like a telephone number; the numbers on
the left, like an area code, represent the “network number,” which is shared
by all the computers on your network (or the part of your network your
computer is connected to). The numbers on the right represent the “host
number.” The portions of an IP address that represent the network number
and the host number depend on how that network is designed.

The network numbers used in IP addresses are issued by an authorized
agency to ensure that no duplicate addresses are used. An organization
assigned a network number can use all of the available host numbers that can
be associated with that network number.

Subnet mask

Some organizations need more IP addresses than are available with a single
network number. More IP addresses can be used with a single network
number by dividing a network into sections called subnetworks, or subnets. A
subnet mask is a set of numbers used in conjunction with an IP address to
identify a portion of the IP address as belonging to a particular subnetwork.
Like an IP address, a subnet mask is a set of four numbers from 0 to 255,
separated by dots (for example, 255.255.128.0).

If you don’t enter a subnet mask, the TCP/IP control panel will provide a
default subnet mask for you. However, the default subnet mask may not be the
best one possible.

Router address

A router address is the IP address for a router—a device that directs
information along the most efficient or appropriate network paths. It connects
two networks that have different network numbers and it contains a list
identifying the addresses of the computers in each network (and other routers
providing connections to different network numbers). When a packet of
information reaches the router, the router checks the address on the packet
and sends it to the part of the network containing that address.
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Routers have their own IP addresses. The IP address of the router being used
by your computer is used by TCP/IP to send information to the correct
network and host. When you use a BootP or DHCP server to configure
TCP/IP, the router address is usually provided automatically. When you use
MacIP, the router address is provided automatically and may change
automatically, based on a number of factors taken into account by your
computer’s software.

If you have a dialup connection to the Internet using SLIP (Serial Line
Internet Protocol) or PPP (Point-to-Point Protocol) software, you do not need
to enter a router address in the TCP/IP control panel.

Name servers, domain names, and domain searching

The domain name system (DNS) is a standard for providing a name
identifying any computer connected to the Internet, and for associating the
name with the computer’s IP address. The DNS also provides a way to
identify some kinds of network services (such as electronic mail relays)
available on particular computers. A computer’s DNS name (or “host name”)
consists of a number of words or letters separated by dots (for example,
“mailserver.west.xyzcorp.com.uk”). Reading right-to-left, it can indicate the
geographic location of the computer (“uk,” or United Kingdom), an
organization type (“com,” or commercial organization), the name of the
organization (“xyzcorp”), and the specific computer (the mail server for the
western region).

In the TCP/IP control panel, the following settings are used with the domain
name system.

Name server address

A name server (or domain name server) is a computer that translates domain
names into IP addresses. If you enter one or more name server addresses in
TCP/IP, you can use host names rather than IP addresses in your networking
software applications. For example, you could identify a host computer as
“infoserver.xyzcorp.com” rather than remembering its IP address.

You can type more than one name server address in the name server address
box. Press Return after each address. You can list as many name servers as
you want as long as your list doesn’t total more than 255 letters and symbols.
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Hosts file

The Select Hosts File button appears only when the TCP/IP control panel is
set to Advanced or Administration user mode. For instructions on setting the
user mode, see “Choosing Basic, Advanced, or Administration Settings,”
earlier in this chapter. 

A Hosts file is a list of DNS (domain naming system) resources. It is stored
on your computer’s hard disk, usually in the Preferences folder inside your
active System Folder. You use a Hosts file in order to easily access network
information you use frequently. This is the same function provided by name
servers. It is recommended that you use name servers rather than a Hosts file.
For information about the format for a Hosts file, see the Appendix.

Domain name searching

TCP/IP can automatically search for computers you partially identify (in a
networking application program) by host name. The process of searching for
a host name is called “resolving” the name. TCP/IP uses the starting and
ending domain names you enter to attempt to resolve a host name within your
domain. TCP/IP uses the domains you enter in the Additional Search
Domains box to attempt to resolve a host name in different domains. You can
list as many additional search domains as you want as long as your list
doesn’t total more than 255 letters and symbols.

Implicit searching appends the starting and ending domain names you
specify to a partial host name you enter.

The starting domain is often the name of your own local network domain. For
example, if your computer is named “workstation.mktng.east.xyzcorp.com,” you
might enter “mktng.east.xyzcorp.com” in the starting domain box.

The ending name is the name of the larger domain containing the starting
name. It must match the end of the local domain. For example, if your
starting domain is “mktng.east.xyzcorp.com,” you could enter “xyzcorp.com”
in the ending domain name box.

The names you type in the two boxes define a range of domain names. When
you use a partial host name, TCP/IP tries to resolve the name by appending
each possible suffix in the range.
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For example, if you have “mktng.east.xyzcorp.com” in the first box,
“xyzcorp.com” in the second box, and search for “www,” TCP/IP tries to
resolve these names:

www.mktng.east.xyzcorp.com

www.east.xyzcorp.com

www.xyzcorp.com

The names you type in the Additional Search Domains box are used as you
type them, and are not used to search a range of domain names.

For example, if the box contains “apple.com,” “university.edu,” and
“nowhere.org” and you search for “www,” TCP/IP tries to resolve these
names:

www.apple.com

www.university.edu

www.nowhere.org

When trying to resolve a host name, TCP/IP submits each name to each
server on your list (in the order they appear in the list). This process
continues until a valid name is found, until all combinations have been tried,
or until a name server reports that the host name does not exist.

An improperly administered name server may incorrectly report that a host
name does not exist. Because such a report stops the search before the next
name server in your list is queried, it is important to make sure that the name
servers in your list are in the proper order. More reliable and complete name
servers should be at the top of the list.
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This chapter includes suggestions for what to try if you run into problems
using the AppleTalk or TCP/IP control panels.

If you’re having a problem and can’t find an answer here or elsewhere in this
manual (or in Macintosh Guide, available in the Guide [h] menu if you’re
using system software version 7.5.3 or later), see the service and support
information that came with your computer for information about contacting
Apple for additional help.

AppleTalk troubleshooting suggestions

I can’t turn AppleTalk on.

Make sure you turn on AppleTalk in the AppleTalk control panel. If you’re
sure it’s turned on in the control panel, check to make sure AppleTalk is also
turned on in the Chooser. If you have other software that can turn AppleTalk
on or off, make sure it’s turned on in that software as well.

I can’t see any network devices in the Chooser.

Make sure your networking cables are properly connected.

Make sure AppleTalk is turned on.

If AppleTalk is turned on, make sure you have chosen the correct port in the
“Connect via” pop-up menu in the AppleTalk control panel.
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If your network number or node number has been set to “User Defined,” turn
off the User Defined setting, then close and reopen the AppleTalk control
panel.

Make sure your network is functioning correctly (contact your network
administrator).

I can’t switch from a serial to an Ethernet connection.

If you use an expansion card to connect to Ethernet, make sure the card is
installed correctly.

Make sure your Ethernet cables are connected properly.

Make sure your network is functioning correctly.

I can’t remember my Administration password.

You can erase your Administration password (along with all of your
AppleTalk settings and configurations) by dragging the AppleTalk Preferences
file (inside the Preferences folder in your active System Folder) to the Trash.
When you open the AppleTalk control panel again, you must reenter all your
settings.

TCP/IP troubleshooting suggestions

I can’t connect to devices outside my local network.

Make sure your router address is correct.

Make sure your subnet mask is correct.

I can connect to hosts by IP address, but not by name.

Make sure you have entered at least one name server address, and that the
address is correct. If you have entered more than one, make sure the most
reliable ones are listed first.

Make sure you have entered valid domain names in the Additional Search
Domains box.
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If you have entered starting and ending domain names for an implicit search,
double-check to make sure they’re correct. (The local and administrative
domain names can be entered only when the TCP/IP control panel is set to
Advanced or Administration user mode.)

My computer does not respond to a “ping.”

Make sure you have an active application on your computer that uses TCP/IP
and can respond to a “ping” from another computer.

Make sure your TCP/IP configuration is correct.

Make sure your network cables are properly connected.

Make sure your network is functioning properly.

I can’t remember my Administration password.

You can erase your Administration password (along with all of your TCP/IP
settings) by dragging the TCP/IP Preferences file (inside the Preferences
folder in your active System Folder) to the Trash. When you open the TCP/IP
control panel again, you must reenter all your settings.
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A Hosts file is a list of DNS (Domain Naming System) resources. It is stored
on your computer’s hard disk, usually in the Preferences folder inside your
active System Folder, and can be used by the TCP/IP control panel. The
information in a Hosts file consists of a series of records that must be in the
following format:

domain name data ;comment (optional)

Domain names must contain at least one dot in order to be used in a Hosts
file. For example: “apple.com” is an allowable name; “apple” is not.

The data in a Hosts file record include the following information, each
separated by one or more space characters. Comments must be preceded by 
a semicolon.

Information Notes

ttl (time to live): the record’s configured lifetime in seconds. This is optional. If it is not
present, or if it is “-1”, the entry is assumed to have an infinite lifetime.

class (optional): the only class currently supported is IN (Internet domain)

type (required): use “A” for host address, “CNAME” for canonical name of an alias, or “NS”
for name server

IP address
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Examples of valid Hosts file records are:

apple.com  A  130.43.2.2  ; address of host apple.com
foobar  CNAME  barfoo.apple.com  ; canonical name for the host whose local alias is “foobar”
xyzcorp.com  86400  NS  biglist.xyzcorp.com  ;  name server for xyz corp.—entry has a 1-week life

To use a MacTCP Hosts file with TCP/IP, make sure all of the listed domain
names contain at least one dot. MacTCP allows the Hosts file to contain
domain names that contain no dots. In TCP/IP, such a name will cause an
error unless it is an alias.

To use a domain name with no dots in the TCP/IP Hosts file, you can use two
records. The first record associates a local alias with a valid name, and the
second resolves the domain name to an IP address. For example, you might
have the following entry in a MacTCP Hosts file:

bigcomputer  A  128.1.1.1

To accomplish the same effect of associating “bigcomputer” with the address
128.1.1.1, a TCP/IP Hosts file needs these two records:

bigcomputer  CNAME  largedomain.xyzcorp.com
largedomain.xyzcorp.com  A  128.1.1.1

The first record associates the alias “bigcomputer” with the valid domain
name “largedomain.xyzcorp.com.” The second record resolves that domain
name to the IP address 128.1.1.1.
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